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Introduction 
 
 
Microsoft Publisher is an easy to use, general purpose desktop publishing package which 
allows you to create professional-looking publications without having to be an expert printer 
or designer. Publisher is simple to learn and in no time you will be creating newsletters, 
brochures, greeting cards, and banners. This manual was written for Publisher version 2000. 
If you are using a different version of Publisher (v98, v7.0, v97) some screen shots will be 
different and some features will be located in different places. However, the concept of 
Publisher has not changed since its inception, making desktop publishing as simple as 
possible. 
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Starting Up 
 
� When you load Publisher it will ask you what kind of publication you would like to create. 
� Whenever you start Publisher you will either be creating a new publication from scratch or using a wizard, 

design, blank presentation, or an existing one. 
� Click on the tabs to tell the program which option you'd like.  
 

 
 

� Publisher comes with hundreds of wizards that can help you get started and make designing your 
publication easier. The wizards are separated into categories based on different types of publications and 
background design. The most common types are Publications, Newsletters, Web Sites, and Brochures. 
They are listed first. 

� To start a wizard just click on the type of publication you would like to create, then click on the Start 
Wizard button. 

 
The next section will explain how to create a publication using a wizard.  If you would rather 
create a publication from scratch, please skip and go to the section titled Creating a Blank 
Publication. 
 
 

Page Wizards 
 
� The easiest way to design a publication is to let a wizard do the preliminary work. With a wizard, layout, 

color design, and other setup options are created automatically by Publisher and all you have to worry 
about is creating the actual content. 

� You may always alter what a wizard has done for you. You may change a font style, insert your own 
picture, and use the colors you want. A wizard just helps you get started. 

� There are 23 different categories of wizards and 7 design categories available to use with an unlimited 
number of potential publications because each category allows you to customize that particular publication 
to fit your personal needs. 

� Just double-click on any category to start that particular wizard. It would be wise to spend a few hours 
going through the different wizards and finding ones that could be of help for your office. 
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� This is an example of how many different possibilities one category of wizards can produce. 
� This is the first step in the Newsletter wizard. It contains 34 separate newsletter styles to help you get 

started. We will not get into step-by-step instructions on each wizard. The programmers at Microsoft have 
already included instructions and helpful hints with each wizard to guide you along.  

 
 
 

Creating a Blank Publication 
 
1. From the startup screen, click on the Blank Page tab. 
2. Full Page will be selected, because we do not want any special folds and we are not creating a web site, 

just click on the Create button. 
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Publisher Basics 
� You use Publisher by placing text, pictures, titles, and other objects onto the screen, moving items around, 

and resizing things that don't fit, until you come up with an acceptable publication. 
� Just like old-time printers used paper cutouts of articles and pictures and then moved them around a table 

until all the pieces fit, Publisher operates on the same principle. 
� Move the text and graphic objects around the screen until they form a coherent newsletter, flyer, or 

brochure. 
 
All objects can be created from using the Publisher Toolbar, which contains all 
the tools you will need in Publisher. In this toolbar there are buttons to activate 
the text tools, graphics tools, tables, and drawing shapes.  

Creating Text Objects 
� There are two types of text objects in Publisher: normal paragraphs and a special type of text used for titles 

called WordArt.  
� To begin writing text you must first create an area on the screen where that text will be placed. This is 

called "drawing a text box". 
 

 Do What … Why … 
1 

Click on the text box tool button.  This will turn your pointer into a "crosshairs".  
2 Place the crosshairs inside the white document 

and left-click and drag the pointer towards the 
lower right. 

The text box will begin to take its shape as you 
drag. This is the area in which your text will be 
placed. 

 
3 The pointer will be blinking, you may start 

typing text. Type in "This is the beginning of 
Publisher training. I hope it goes well". 
Don't worry if you can't see the actual letters 
and they appear like "#" symbols. 

You may change the font like a Word Processor by 
selecting the text within the text box clicking on the 
font and size selectors at the top of the screen. 

 
 
 
 
 
 
 

You can't see the actual letters because the page is zoomed too far out. To 
zoom in closer, just click on the "+" button at the top middle of the screen. 
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Creating WordArt Objects 
� WordArt is a special kind of text that is used for titles and large headlines. WordArt allows you to 

manipulate the text you type to be stretched, zoomed, and rotated to create special effects.  
� To create a WordArt title for our publication follow these steps: 

 Do What … Why … 
1 

Click on the WordArt tool button.  This will turn your pointer into a "crosshairs".  
2 Draw a medium-sized rectangle towards the 

top of the screen. 

 

� You have to tell Publisher where to place the 
WordArt title. 

� You may also select which font to use for you 
WordArt title. Just click on the font selector at 
the top of the screen. 

 
3 A window will appear that you may type in 

the title of this publication: type "Publisher 
Training". Then click on Update Display. 

 

The Update Display button is the OK button for 
WordArt. When you have typed in a title, click this 
or press Enter. 

4 At the top of the screen click on the down-
arrow next to Plain Text and choose a shape 
by clicking on one. 

 

This menu contains the "Shape Shifters" in 
Publisher which allow text to be displayed 
vertically, rolling, in circles, and many others to 
give your titles a special effect. 

5 Click on the "A" button with the 4 arrows 
emanating from it. 

 

This will stretch out the text to FILL UP the entire 
WordArt frame. Some shape shifting is not readable 
unless the text is stretched out to fill the frame. 

6 Click anywhere else outside the WordArt 
frame to tell Publisher you are done with this 
WordArt. 

 

Feel free to try many different types of shapes for 
your WordArt as well as trying the many buttons in 
the upper-right of the screen. These buttons activate 
WordArt features such as rotation, shadows, and 
shading. 

 
 
 
 
 

To edit existing WordArt, DOUBLE-CLICK on it. The WordArt menu 
will reappear and you may change the words and/or effects. 
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Creating Graphics Objects 
� Inserting pictures into Publisher is easy as creating a text box. Publisher was designed to deal with pictures 

and clip art the same way as it does with words … everything is an object.  To bring in a picture you have 
scanned, downloaded from the Internet, or from Clip Art, you must first tell Publisher where you want the 
picture to go. 

 Do What … Why … 
1 

Click on the picture tool button..  This will turn your pointer into a "crosshairs".  
2 Draw a box somewhere on the screen where 

you wish to place your picture. 
Wherever you draw the box is the location the 
picture will be inserted to. 

3 Click on the Insert menu, then click on 
Picture, and Clip Art.  

 
 

Here is where you can choose the option that best 
fits where your picture is coming from (scanner, 
Internet, Clip Art). For the sake of this lesson we 
will take a picture from the stock images of Clip 
Art. 

4 Unlike the previous version of Publisher, 2000 
has a much expanded clip art selection.  First 
select a category, and then you will see the 
pictures.  Select any picture by clicking on it, 
then click on the Insert Clip button.  

 

 

In this case, it doesn't matter what picture you 
choose. This is just practicing the procedure for 
inserting pictures. 
 
Unlike Publisher 98, 2000 sizes the picture to the 
selected box.  If you then wish to change the 
dimensions of the picture, simply click and drag on 
the controls along the sides of the picture box. 
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Creating Drawing Objects 
� In addition to inserting in previously created pictures, Publisher allows you to create graphics from right 

within the program. These tools aren't meant to create actual pictures (they are pretty crude tools) but you 
may draw lines, arrows, ovals, and rectangles to enhance your publication. 

 
1. Click on the Custom-shapes button  and choose a drawing object from the 

list of 36 
2. The pointer will turn into a crosshairs and then click and drag the object onto 

the screen. You will determine the shape and size by your dragging. Simply let 
go of the mouse when you're done. 

 
 
 

Moving and Re-Sizing Objects 
 
� Anything that is contained within a frame is considered by Publisher to be ONE object. For instance, the 

text you created "This is the beginning of Publisher training" is one object, as opposed to 2 sentences or 12 
words. 

� Because this is so, it is easy to move objects around the screen and to resize objects to get them to fit 
correctly together. 

 

Moving an Object 
 
You may move this text to any place on the screen by simply moving the text box itself. 
To move the text box: 
 
1. Click on any word of the text. This will select the text 

box.  
2. Now place the mouse pointer directly on the dotted line 

forming the boundary of the text frame. It will turn into 

a moving van.   
3. Click and hold down the mouse and drag the text frame 

into its new location. 
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Re-Sizing an Object 
� Re-sizing is as important as moving objects around the screen. Desktop publishing constantly requires the 

technique of shaping and sizing pictures, titles, and text frames to get everything to fit correctly on the 
page. 

 
To re-size the picture: 
1. Click on the picture to select it.  
2. Now place the mouse pointer in any corner and it will 

turn into a double-sided arrow.  
3. Click and hold the mouse and drag it towards the center 

of the picture to make is smaller or away from the 
center to make it larger. You will see the frame being 
re-sized. 

4. Release the mouse and the picture will re-draw itself within the new borders. 
 
 
 
 
 
 
 
 
 

Quirks about Re-sizing Text Frames 
� When re-sizing a text frame, Publisher automatically reformats the text within it, keeping the font style and 

sizes the same. 
� However, if you make the frame smaller, all of the text may not fit. If the text fits within the box, the 

bottom of the text box will be blank. 

� If the text does NOT all fit within the text box, the icon changes to three boxes and a letter A  
warning you need to re-size the box to make all the text fit. 

� If re-sizing the box is not an option due to space constraints on that page, you may connect this text box to 
one on a different page allowing the text to flow from one box to the other. See Text Autoflow on page 16 
for instructions on how to do this. 

 

 

 

 

 

PUBLISHER TIPS & TRICKS 
To re-size a picture that retains its proportions, hold down the SHIFT 
key while dragging the mouse towards the center or away from the 
picture. This will re-size both the height and width equally to keep 
the picture from becoming stretched and awkward-looking. 

PUBLISHER CHEAT SHEET 
Blank - the text fits within the box created for it. 
 

 - the text does NOT fit within the box. 
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Layout 
 
� Now that we have an example of each of the basic objects within Publisher; text, graphic, and WordArt, we 

can now learn about page layout. 
� Layout is the act of arranging the objects around the page to fit like pieces of a puzzle. One of Publisher's 

distinguishing qualities is its ease of layout control. 
 

Zoom Control 
� Publisher allows you to quickly zoom in and out of a publication by clicking on the zoom controls at the 

bottom of the screen. 
� There are reasons why Publisher makes zooming such an integral part of the design process. In order to 

type in text and actually see what you're typing, instead of unreadable characters: , zoom in 
to at least 75%. However, at this magnification you can't see the entire publication so you can't tell whether 
the text you have entered is in the proper location on the screen. If this is the 
case then zoom out, usually to 50%.  

� To zoom in or out, click on the plus or minus buttons at the center top of the 
screen.  

� If you click directly on the current percentage , a menu will pop-up with all zoom options and you 
can select from that list. This is useful if you need to move more than one zoom level and your page has a 
lot of complicated graphics that must be redrawn by Publisher each time you use the zoom. 

 
 
 
 
 
 
 
 
 
 
 

Layout Guides (margins) 
� Layout Guides are Publisher's equivalent of page margins in other programs. These guides show you where 

the margin area of your publication is. 
� You may set the layout guides to any width you'd like. A dotted-blue line will surround the workspace 

showing you where the edges of the workspace are.  
� If you change the margins in Page Setup, it will be reflected on the layout guides you see on the screen. 
� However, objects that are placed outside the layout guides WILL still print. Layout guides are only there 

for your convenience, the computer does not care if you place objects outside the lines or not. 
� Your printer itself does have a limit to how close it can print to the edge of the page. This limit will vary 

from printer to printer. 

The zoom control is one of 
the most oft-used features of 
Publisher. Get good at it. 

You can't do a print preview in Publisher, that is why 
you use zoom to view the entire page. 
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To set the layout guides. 

 Do What … Why … 
1 Click on the Arrange menu and then select 

Layout Guides. 

  

This will bring up the Layout Guide window 
allowing you to set your virtual margins. 

2 Change the left guide to be 1.5 inches. Then 
click OK. 

 

Pretend we are going to place our publication into a 
3-ring binder. We want to have plenty of space 
along the left margin for the 3-hole punches. 

 
 

Move to Front, Send to Back 
� Because Publisher operates in the world of objects, sometimes those objects will overlap onto each other. 

Since the computer can't display two objects that are in the same place, what decides which object has 
priority? The answer is you decide using the Move to Front, Send to Back controls. 

  Do What … Why … 
1 Click on the picture to select it. Then move it 

so it overlaps the text box that you created 
earlier. 

 

� We need to practice determining how objects 
react when placed on top of each other. 

� Because we created the picture object AFTER 
the text object, it is automatically given priority 
and placed on top of the text box. 

� Fortunately, Publisher is smart enough to 
realize that the text is being hidden and 
rearranged the text so it is displayed on the 
screen. 

2 To move the picture to the background behind 
the text, click on the picture to select it, then 
click the Send to Back button. 

 
 

� Placing objects on top of one another is called 
"layering". 

� You may layer as many objects as you'd like. If 
you are layering more than 2 objects, use the 
"Bring Forward" and "Send Backward" 
commands in the Arrange Menu. 
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3 Click on the picture and click on the Bring to 

Front button. 

 

Just for practice, bring the picture to the front of the 
text box and notice how the objects change 
positions even though neither of them moves on the 
screen. 

 
 
 
 
 
 
 

Grouping 
� Even though every object can be moved around the publication separately, sometimes it is necessary to 

keep two or more objects together. 
� An example would be a text box caption which describes a picture; these are separate entities but ones 

which would need to be kept together, even if they were moved to different positions. The way to keep 
multiple objects together is called Grouping. 

 Do What … Why … 
1 Click on the picture to select it. Then hold 

down the SHIFT key and click on the text 
box. 

 

� This is called multiple selection. We are 
selecting two objects at the same time because 
we need to tell Publisher which objects to place 
into one group. 

� Notice the button with the picture of two puzzle 
pieces which appeared below the selected 
objects. This shows us that while we have two 
objects selected, they are NOT part of a group. 

3 Click on the two-puzzle-piece button 

 

� This will bring the puzzle pieces together and 
form one group between the two selected 
objects. 

� Notice that the selection box has been expanded 
and now surrounds both objects. 

�  

4 Click somewhere else, away from the group. 
Now click back on the group and then move 
the group towards the top of the screen. 

� For practice and to show how both objects have 
become one and will move together. 

 

Sometimes when moving objects around you will "lose" an object, which means 
that a smaller object will be placed behind a larger one, not allowing you to see it. 
If that happens, click where you think the lost object should be, then move 
whichever object has been selected to the side, your lost object should reappear. 
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To ungroup objects, simply click on a group to select it, you will get the grouped-button (the puzzle pieces are 
connected) signifying that there are multiple objects here forming one group. Then click on the button to 
separate the puzzle pieces and the actual objects. You will now see the individual objects with selection boxes 
around them. 

 
 
 
 
 
 
 

Background 
� Publisher has a layer called the background that appears behind every page. This background layer is used 

to repeat things on every page, such as headers, footers, and page borders. 
� It is similar to a template used in word processing programs where the layout of certain documents is 

similar but the content changes. 
 
1. To create a background for your publication, click on View, then Goto Background. 
2. The screen will go blank because we are now looking at the background layer, and no objects have been 

placed here yet. 

3. Click on the Box drawing tool , the cursor will turn into a cross-hairs. 
4. Create a border around the entire page by placing the cross-hairs in the upper-left corner, but not outside 

the layout guides, and dragging the box down to the bottom-right corner. The page should now be enclosed 
by a rectangle border. 

5. Click on View, then Goto Foreground. 
6. The border will be displayed and every new page that is created within this publication will contain that 

border. 
 

 

 

 

PUBLISHER TIPS & TRICKS 
You can edit any single object within a group without having to ungroup the 
objects. For example: you may edit text by clicking on that text within a group. 
Publisher will highlight the text box in pink and allow you to make changes. 

Always remember to switch back to Foreground view when you're done with the 
background. You can tell whether or not you're in background view because the 
Page # indicator in the Bottom center corner is replaced by a background R 
character. 
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Managing Your Publications 
 
Flyers and posters will usually be one page but since so many people use Publisher for brochures and 
newsletters it is important to learn about managing your publications. 
 

Inserting Pages 
� In this lesson, we have created three objects and they have all fit on the first page. But for practice we will 

insert a second page and then delete that page to demonstrate Publisher's page controls. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click on the Insert menu. 
2. Click on Page. 
3. Decide how many pages to insert and, more 

importantly, whether you want to place the new 
page before or after the current one. 

 

 

Publisher Fact 
The new page that you have inserted 
will retain the same measurements 
for the layout guides and background 
as the original page. 

  

Kevin Presley       September 2000    Page 13 



 

 

 
 

Navigating Through Pages 
 
Navigation in Publisher 2000 is accomplished through numbered page indicators listed at the bottom of the 
window.  To see any particular page, just click that page number.   
 
 
 

 
 
 
You may also go directly to any particular page by selecting View, and then Go To Page.  This will open a 
dialog window that will give you statistics on the number of pages in your publication and allow you to choose 
the page you want displayed. 
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Deleting a Page 
First, be sure you actually want to delete an entire page. If you do, go to that particular page and click on the 
Edit menu, then click on Delete Page. Publisher will ask if you really want to delete this page. Click OK for 
yes. 

 

Advanced Text Techniques 

Importing Text from Other Programs 
� Publisher is great for creating and arranging objects on the screen to form a coherent publication. However, 

one role it is not geared for is that of a word processor. You can enter text into Publisher like we've seen, 
but it is very difficult to actually create large bodies of text from within Publisher. Doing so is awkward 
and cumbersome. You would be better suited to write your articles in a word processing program (Word, 
WordPerfect) then import them into Publisher. 

� However, if you do this, be aware that text formatting such as font and size may not transfer, so it may be 
best to format the text after going to Publisher. 

 
There are some issues that you need to be aware of when importing text files; one of which is 
text overflow. Very often the file you are importing is larger than the text box you are putting 
it into. How do you handle that? That will be discussed in this section. 
 
 
 
 

 Do What … Why … 
1 

Click on the text box tool button.  This will turn your pointer into a "crosshairs".  
2 Place the crosshairs inside the white document 

and left-click and drag the pointer towards the 
lower right to create a fairly large text box on 
Page 1. 
 

The text box will begin to take its shape as you 
drag. This is the area in which your text will be 
placed. 
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3 Click on the Insert menu, then select Text 

File. 

 

The Insert Æ Text File command is only available 
when you have a text box selected. The best method 
to do this is to create a text box like in Step #1 then 
immediately click on the Insert menu. 

4 Double-click on the Mouse file within the 
Windows folder. See right for instructions. 

 

1. Click on the down-arrow to the right of the 
Look-In box.  

2. Scroll up and click on Desktop. 
3. In the large white section double-click on My 

Computer. 
4. Double-click on (C:) 
5. Double-click on Windows. You may have to 

scroll to the right to find the Windows folder. 
6. Scroll to the right until you find a file called 

Mouse. 

5 Click NO at the prompt. 

 

Publisher has warned you that the text file you are 
inserting is larger than your text box. Answer NO at 
this point because Autoflow has not been discussed 
yet. How to work around Autoflow problems will 
be discussed next. 

 
 
 
 
 
 

Text Autoflow (also called Connecting Frames) 
 
Text overflow is not an issue to worry about only when a text file is imported, like the above example. The 
pages of newsletters are crowded places and often require splitting articles. Publisher has built-in support for 
placing part of an article on page 1, for example, and pasting the rest of that article on page 4.  
 
Practice using Autoflow following the instructions below. 
 
 
The file we have just imported (mouse.txt) is larger than the text box we have assigned it. Because there is not 
enough room on Page 1 to simply enlarge our text box to allow the text file to fit, we will need to use the 
Autoflow feature. 

There are some instances where the text file you are importing will fit within the text box. 
If that is the case you will not receive the Autoflow warning and the file will appear in 
your publication as requested. 
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 Do What … Why … 
1 Click on Insert, then Page, then click OK. � Because we already know that the text will not 

fit into the box on Page 1, we need to create a 
text box on another page.  

2 Draw a large text box on the blank Page 2. � This will be the destination text box that the 
article from Page 1 will flow into. 

3 Return to Page 1 using the bottom navigation 
buttons. 

 

4 Click anywhere inside the text box that 
contains our article to select it then click on 
the Connect Frames button. 

 

� Since Publisher knows the text is larger than 
the text box can display it displays this button 
to activate Autoflow. 

� The cursor will turn into a pitcher.  

5 Click the next-page button to return to Page 2. � With pitcher in-hand we are now going to 
select which text box to flow the article into. 

6 Position the pitcher-cursor inside the text box 
you created in Step #2 and left-click 

� The pitcher will change shape into a emptying 
pitcher. Wherever you click now will become 
the destination text box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To demonstrate a neat feature of Autoflow, return to Page 1 and re-size the 
beginning text box. The article will automatically adjust itself and place as 
many words as it can in the first text box before continuing on the second 
page. You do not have to worry about cutting text off if you resize the box. 

PUBLISHER TIPS & TRICKS 
You may include a "Continued 
On" and "Continued From" label 
by right-clicking in either text box 
and select Text Frame Properties.  
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Text Import Limitations 
Some file types are not able to be imported. Here is an extract from Publisher’s help files. 
 

File formats that Publisher converts 
Publisher can convert the file formats listed below. In most cases, Publisher can 

preserve the character and paragraph formatting of the text.  

• Publisher files 

• Plain Text (files usually with a .txt extension) 

• Rich Text Format (files with an .rtf extension) 

• Microsoft Word for Windows versions 2.0, 6.0, Word 95, Word 97, and Word 2000 (files with a .doc 
or .dot extension) 

• Microsoft Word for Macintosh versions 4.0, 5.0, 5.1, 6.0, and Word 98 

• Microsoft Works for Windows versions 3.0 and 4.0 word-processing files (files with a .wps extension) 

• WordPerfect for MS-DOS version 5.1 

• WordPerfect for Windows versions 5.0, 5.1, 6.0, 7.0, and 8.0 

• Microsoft Excel for Windows versions 2.0, 2.1, 3.0, 4.0, 5.0, Excel 95, and Excel 97  

Note 
• Publisher does not convert HTML. 

• If you install other Microsoft products, you may see more file formats than are listed here.  

 
 
 

Deleting Objects 
� Most objects can be easily deleted by selecting them with the mouse and either pressing the delete key or 

right-clicking the mouse and selecting Delete Object. 
� Text boxes are different in that once you select them the actual text becomes active and pressing the delete 

key on the keyboard merely deletes a character, not the entire text frame. 
� For that, you will need to right-click on a text box and select Delete Text Frame. 
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Text Wrapping 
When creating publications it is sometimes important to bring text as close as possible to other objects, 
especially pictures. Publisher makes it easy to wrap articles around pictures and titles. Graphic objects (pictures 
and clip-art) and WordArt objects (titles) can both be configured to have text be wrapped around them.  
 
1. Right-click on the picture you wish text to be wrapped around. 
2. Select Change Frame, Picture Frame Properties. 
3. You now have a choice whether to keep text away from the picture by selecting Entire Frame or allowing 

the text to be placed right up to the edge of the picture by selecting Picture Only. 
4. You may do the same with WordArt objects, just right-click on a WordArt object and select the same 

options. 
 

 

 
 
 
 

Example of Entire Frame Wrapping Example of Picture Only Wrapping 
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Saving Publisher Files 
When it times come for you to save your publication, there are several options and issues of which  you need to 
be aware. First, Publisher has its own file format. The filenames will have a .pub extension. You will NOT be 
able to open a Publisher file with another program, not even Microsoft Word. Be aware of this if you are 
collaborating on a project with other people. 
 
To save, click on the File menu, 
then, if you have not saved this 
publication yet, click Save As. A 
new screen will appear. The 
components of this screen are 
discussed below. 
 

 
 
 
 
 
 
 
 
 

Save All Text as File 
Because Publisher does not allow any other program to open its files, the Save all Text as File option can be 
quite useful. This option allows you to save all the text within a publication as a separate file. You may then 
open that file in a Word Processor or share it with a person who does not have Publisher. For example, you are 
creating a newsletter with several articles in it. Use this feature to save all the articles as a separate file. Then 
send the file to someone you are collaborating with, who can make appropriate changes to the article, before 
sending it back to you to import into the publication. 
 
 
 
 
 

  

Kevin Presley       September 2000    Page 20 



 

 

 
 

Template 
A template is a model or blueprint that you base new publications on. A template usually contains some of the 
basic layout and formatting, and perhaps even some of the text and pictures that can be re-used from publication 
to publication. A good example is office letterhead. Although the information will change every time, the logo 
and office address will remain the same and in the same position. 
Creating a template in Publisher is as simple as clicking the box labeled Template. Any publication can be a 
template. 
 
1. Create your template on a new blank screen. 
2. Click File Æ Save As, and click the box labeled Template. 
3. Close the template. Remember there is a difference between 

CREATING the template and USING the template for a 
publication. 

4. Click File Æ New Publication. 
5. Click on the Templates tab. The template you just created 

should appear. Double-click on it. 
 
 
 

Backup 
A backup copy is a safety net against the loss or corruption of an existing publication. A backup copy has the 
same name as the original file, preceded by BACKUP OF. For example, BACKUP OF FAIR_POSTER.PUB 
is the file name for the backup of the publication FAIR_POSTER.PUB. Publisher automatically creates the 
backup file if you select the Save with Backup option. 

 
 
 
Another advantage to this feature is that the backup copy of a publication is one save behind the most recent 
save. For example, if you save your publication three times, the backup copy looks the way your publication did 
when you saved it the second time.  This is handy if you make changes, save your work, and then decide you 
don't like your changes. You can then use the backup copy to start over. Just click on File Æ Open, then find 
the BACKUP OF … file and open that instead of the original publication. 
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Opening Publisher Files 
 
1. If you start the program the opening screen will give the option for using wizards to create a new 

publication, start with a blank page, use a template, or open an existing publication. Click on the Existing 
Files tab. 

2. This will open a standard Windows file selection window. 
 

Advanced Graphics Techniques 

Rotating and Flipping 
You may rotate any object and horizontally or vertically flip certain other objects. Follow these steps to rotate a 
WordArt title you have created. To flip an object, the commands are in the same menu as Rotating and you will 
see them if you follow the steps below.  
 
1. Create a WordArt object in the publication. 

See the section on Creating WordArt Objects 
(page 5) if you are unsure of how to do this. 

2. Click on the WordArt object to select it. 
3. Click on the Arrange menu, then 

Rotate/Flip, then Custom Rotate. You may 
also click on the custom rotate button located 

on the toolbar.  
4. You may now press the back arrow to rotate 

left and the right arrow to rotate the object to 
the right to any degree you wish. 

5. Click Done when you are finished. 
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Color Fill and Shading 
You may fill in any object with a solid color or any create your own combinations of gradient, tinting, and 
patterns, to create jazzy effects in your publications. 
1. Click on any text box to select it. (this will also work with any WordArt or Drawing objects). 

2. Click the Object Color button in the upper-right corner of the screen. You will get a choice of many 
solid colors. Click on one to try it. If it does not 
look good simply repeat these steps and choose a 
different color.  

3. After trying a few different colors, click on the Fill 
Effects button below the solid colors. 

 
4. Try different combinations of Shades and Gradients 

for the background of your text box. Try as many as 
possible to get used to this feature. 

Borders 
Every object may also have a border to outline it with. Publisher comes with hundreds of pre-designed borders 
called Border Art that are useful in spicing up a publication. 
 
1. Click on any text object to select it. (this 

will also work with any WordArt or 
Drawing objects). 

2. Click on the Border button in the upper-

right corner of the screen.  You 
will have four different-sized line widths 
to use as a border. Try a couple of them 
to see the differences. 

3. Go back to the Border button and click 
on More Styles … 

4. Here you may specify your own border 
width and even the color of the line that 
makes the border. Try a few custom 
border widths and colors. 

5. Come back to this Border Art window and select the Border Art tab. Now you have access to Publisher's 
pre-designed borders. Click on one to apply it to your text box. Try many different border arts to find one 
that fits your article. 

 
 
 
 
 

PUBLISHER TIPS & TRICKS 
To place a border around the entire publication just 
draw a box from corner to corner, then click on the 
Border button, then More Styles…, then Border Art. It 
will turn the box line into whichever Border Art you 
choose. 
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Additional Help and Resources 
 

On-Line Help 
Publisher has a built-in help system to assist your creations and help you understand using Publisher. Just click 
the Show Index or Show Help buttons in the lower-right of the screen. From here, you may jump to any help 
section by typing in the nature of your question. 
 

On the Web 
This is Microsoft's site for Publisher. Here you will find product information, technical support for Publisher, as 
well as downloadable patches and updates. 
 
http://www.microsoft.com/publisher/ 
 

On-Site Training 
If your office would like on-site training on Publisher or any other program supported by Extension Computing, 
please contact Kevin Presley Kevin.Presley@orst.edu 
 

Training Materials 
There are several excellent tutorials available to learn Publisher as well as for experienced Publisher users to 
learn the latest tips and tricks. 
 
How to Use Microsoft Publisher98 by Rebecca Reese published by Sams 
 
Using Microsoft Publisher for Windows95 by QUE publishing 
 
Learn Internet Publishing with Microsoft Publisher97 by Russell A. Stultz 
 
 
 

ECTU has these training materials available for county agents and staff 
to check out and use. To inquire about these materials, please contact: 
Kevin Presley  Kevin.Presley@orst.edu 
… or any other member of the Extension Computing Team 
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